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New in this Version 

BarFly(Carbon) Version 1.74

Changes since version 1.73

¥  Program is now compatible with OS 10.5.2.
¥  Fixed a couple more bugs in Expand Guitar Chords.
¥  Fixed a bug which prevented intonations from working properly.
¥  Fixed a bug which caused the Recent Files menu to be cleared if the user saved a file without resources.
¥  Fixed a bug which caused files to fail to open if they contained bad symbol or macro definitions in the file header.
¥  Fixed a bug which interfered with the display of music if the abc contained comments at the end of lines.
¥  Changed the menu shortcut for Utilities>Format tune to Option-F to resolve a conflict with the File Search 
command.

Changes since version 1.72

¥  Registered users can now export multiple tune files in a single operation.  In split-screen mode, use command-click 
or shift-click to select any subset of tunes in the index pane (or command-option-A to select all).  Export>Picture, 
Export>Quicktime movie, Export>AIFF audio file and Export>Standard Midi file will all then export all of the 
selected tunes.  Files are named according to the tune titles.
¥  There's a new  command (Remove Selected Instrument) on the Instrument menu.  You can still remove instruments 
by holding down the Option key, but this way is more obvious.
¥  Add an Instrument will no longer allow the installation of duplicate instruments in the Instrument menu.
¥  There's a new popup menu in the Save AsÉ dialog which gives you the option to save a copy of the document as 
plain text without resources.  This removes all formatting from the text, but leaves the original window (and its 
corresponding file, if any) unchanged.  You will get an error message if you try to overwrite the original file, since it's 
still open.
¥  You can now undo a Paste Plain Text operation.
¥  Fixed a bug in Expand Guitar ChordsÉ which caused an occasional crash.
¥  Fixed a bug which could cause a crash when exporting a tune to a standard midi file on Intel-based Macs.

Changes since version 1.71

¥   There's a new Sort TunesÉ command in the Utility menu, which allows you to sort abc tunes according to up to 
three sort keys.   <file://:BarFly Commands##61565>
¥   Files with mixed line ends are now handled appropriately.
¥   When using File SearchÉ, matches found in files with PC line ends are now located accurately when the file is 
opened by command clicking on the file reference.
¥   Fixed a couple of bugs which caused the program to ignore the comment symbol % in some places, and to report 
errors if there was a commented-out K: field in the tune header, or if a comment was added to a V: field.  Also fixed a 
bug in the player which caused commented-out lines starting with a V: field to be played erroneously.
¥  Fixed a bug in Expand Guitar ChordsÉ which sometimes gave timing errors in the chord voice when there was a 
triplet in the corresponding melody.

Changes since version 1.70

¥   There's a new BarFly Help menu which allows you to search the Documentation folder, and open any file in it 
quickly, without having to navigate to it.
¥   The Stack Windows command (Windows menu) now arranges the windows a bit more tidily.
¥   All of the files to which the program refers (Stress programs, Chord definitions, Macros and Documentation files) 
can now be aliases, so if you make custom versions of these files you can keep them elsewhere, avoiding losing them 
when you get a new version of BarFly and trash the old BarFly folder.  Please note that only the files themselves can 
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be aliased;  the Macros and Documentation folders must still be real folders.
¥   Fixed a bug which caused damage to files over 32K in size when using Unix line ends.
¥   Fixed a bug which could cause a crash under some circumstances when using the Format Tune command.
¥   Fixed a bug which caused Export>abcm2ps to fail on the second and subsequent operations under OS X 10.1.x.
¥   Fixed a bug which caused multivoice abcs which contained a line starting with a redefinable symbol to report a 
spurious error on display.
¥   Fixed a bug which caused a crash when displaying a multivoice abc with an incomplete triplet at the end of a line 
of music.

Changes since version 1.61

¥   Music can be displayed using shape notes.  Both the Sacred Harp (FaSoLa) and Aiken systems are supported.  For 
more info Command-click here :
      <file://:BarFly Commands##42879>
¥   In multi-voice abc you can now use descriptive names as voice labels, rather than numbers, e.g. [V:Treble].  The 
old (and long deprecated) format which allowed the use of V: fields at the start of a line of music without the square 
brackets will no longer work, and you will get an error message.
¥   There is a new utility command to convert a whole file of tunes containing old-style V: fields to the new format. 
<file://:BarFly Commands##60177>
¥   Added Command-key equivalents for many more menu commands.   
¥   The Paste Plain Text command now has its own menu entry, and its own Command-key (Command-Option-V).  
<file://:BarFly Commands##10779>
¥   There is a new Edit menu command Enter Search Text, which enters the selected area of text from the front 
window as the search string, so you can then just hit Command-G to search for the same text further down the page.  
<file://:BarFly Commands##11165>
¥   Fixed a bug which could cause the Expand Guitar Chords routine to crash when dealing with tunes with metre 
changes.
¥   Fixed several  interacting bugs which prevented multivoice abcs containing multiple gracenotes (e.g. pipe music) 
from displaying properly.
¥   All dialogs can now be cancelled using the Escape key.

Changes since version 1.60

¥   The Export>Standard Midi File routine has been re-written to bypass Quicktime, thus avoiding a long-standing bug 
in Midi generation.  It can now produce either format 0 or format 1 Midi files. Command-click here for more info:  
<file://:Export/Import##3014>
¥   Fixed a bug which caused the index to be wrongly sorted under some circumstances.
¥   Fixed a bug which caused  a spurious "Tie used as slur" message when playing tunes with part-order set in a P: 
field in the header.
¥   Fixed a bug which messed up the music display when a staff ended with a chord (with no barline at the right hand 
end ).
¥   The Change Default Note Length utility command now deals properly with notes written with a double slash (e.g. 
A//).
¥   Fixed a bug which could cause a hang when displaying a tune with an empty first title field.

Changes since version 1.55

¥   The program now uses Quartz antialiasing and font metrics, making both this text, and text printed in the music 
pane look nicer.  You can turn it off under General Preferences if you want.
¥   The text editor can now have embedded pictures.   Just paste them in at the insertion point.  Note that the editor 
prefers to paste text, so if you want to paste in a picture make sure that there is no text on the clipboard;  e.g. if you 
want to copy music from the music pane to paste into the text make sure that there is a zero-length selection in the text 
pane otherwise you will just copy and paste the selected text.
¥   A new command Make Incipit Index (under the Utility menu) can be used to create cheat sheets - a window 
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containing a list of tunes with a picture of the first few bars of each.  If the original window was in text mode the tunes 
will be listed in order of their position in the file, otherwise they will be listed in the order specified in the index pane.  
The size and appearance of incipits depends on the Page Size, Staff Height and Staves per Page settings in Viewer 
Preferences, so you may wish to experiment with these settings.  Command-click here for more info: <file://:BarFly 
Commands##56280>
¥   The program can now export music as Quicktime TUNE resources, adding them to an existing file.  This is aimed 
at programmers who wish to use BarFly to add music to another program e.g. games.  
 <file://:Export/Import##8036>
¥   The command-key equivalent for Un-Comment Selection in the Edit menu has been changed from Command-H to 
Command-T.  Command-H is now used for the Hide BarFly command in the Application menu (as in all other OS X 
apps).
¥   You can now make the program run in the Classic environment if you want (do a Get Info in the Finder and check 
the checkbox).  This can occasionally be useful, for example if you want to use an older version of Quicktime which 
won't install under OS X.
¥   Fixed a bug which caused graphic selection to malfunction in tunes with global accidentals.
¥   Fixed a bug in Expand Guitar Chords which could cause second repeat markers to be omitted in the accompaniment 
voice under some circumstances.
¥   Fixed a bug which caused notes on a staff with a clef other than treble to be wrongly placed if the inter-line spacing 
was an odd number of pixels.

Changes since version 1.54

¥   There is a new utility command Change Default Note LengthÉ, which allows you to change the L: field and adjusts 
all the note lengths in the tune to match.  This can operate either on a single tune, or on all the tunes in a file.
¥   Utility routines which operate on the whole file (Error check all tunes, Check key assignments, Change default note 
length) now display a circular progress symbol (next to the error icon).
¥   The TransposeÉ routine has been completely overhauled, and should no longer make enharmonic errors.
¥   The options set in the Line Ends > menu are now saved in the %%Bfly line when you record the current settings in 
a tune.
¥   The Line Ends > submenu has been moved from Utility to the View menu where it belongs.
¥   Fixed a bug which could cause the program to hang when using the Play from insertion point command on a tune 
with illegal characters in it.
¥   Fixed some problems with the Staff break only on ! option.
¥   Fixed a bug which caused the program to lose track of recent files after using some commands in the Utilities 
menu.
¥   Fixed a bug which caused the Play command, and some of the utilities commands to object to tunes which contain 
[square brackets] in W: lines.
¥   Fixed a bug which could cause files to become corrupted when saving in PC format.

Changes since version 1.53

¥   Just a fix for a bug which could cause the BarFly preferences file to grow without limit. 

Changes since version 1.52

¥   There is now a Recent Files submenu attached to the File menu, so you can quickly re-open any of the last ten files 
you've used.
¥   When you hold the cursor over a line in the text pane of a window, the corresponding line number is displayed at 
the bottom left.  (Useful for those using abcm2ps, which reports errors with line numbers.)  Note that the line numbers 
indicated by BarFly are actual line numbers, and will differ from those reported by abcm2ps if there are lines long 
enough to wrap around.
¥   In split-screen mode, using the arrow keys to move the cursor around no longer causes a screen refresh after each 
keystroke.
¥   The Coda has been added to the list of symbols (by default it's attached to the letter "O", but it's a redefinable 
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symbol.
¥   Symbol definitions can now be written between exclamation marks or + signs (if you really must!).
e.g.
U: S = segno
U: S = !segno!
U: S = +segno+
will all work the same.
¥   Preferences for the Analyse Melody command are now persistent.
¥   A bug which caused rests at the end of a music line (with no bar line following) to disappear is fixed.
¥   The Import MusicXML and File Utilities commands will now work with un-typed files, provided they have an 
appropriate file extension (e.g. .xml, .abc or .txt).

Changes since version 1.51

¥   The Preferences command in the BarFly menu is no longer disabled (but you will only get General Prefs that way).
¥   Windows now have proxy icons.  (The small icon next to the window title which represents the file).  If there are no 
changes to be saved you can move the file by dragging the proxy icon out to the Finder.  If you drag it to the trash, it 
will close the window.
¥   The program is now aware of changes which you may make to open files in the Finder, and will not lose track of an 
open file if you move or re-name it.  Dragging an open file to the trash closes its window.
¥   Under OS X the close button in windows now has a dot in it if there are changes to be saved.
¥   Fixed a bug which caused a crash under OS X if you commented-out all or part of the first line of a song with 
aligned words.
¥   Some adjustment to note spacings in aligned MultiVoice abc.
¥   Fixed a bug which could cause half-flags on beamed notes to be drawn in the wrong direction when there was an 
adjacent embedded gracenote.  (Common in pipe music.)
¥   The Page Up, Page Down, Home and End of Document keys now work again.
¥   Restored the checkmark which had gone missing from the Align Voices menu command.

Changes since version 1.5

¥   Fixed a bug which caused export of pictures to fail under OS X.
¥   Using either ` or Option-space as a text spacer within abc no longer causes a problem when used before a slur 
bracket.

Changes since version 1.41

¥   There are now some additional options to control the way in which pagebreaks are placed when printing multiple 
tunes.  You can opt to print the tunes contiguously (as in previous versions), to avoid splitting short tunes across page 
breaks, or to start a new page for each tune.  See the Printing document:  <file://:Printing##8720> 
¥   When running under OS X, BarFly now provides an interface to abcm2ps.  This is a Unix command-line tool which 
converts abc to postscript, so if you have a postscript printer it gives you an alternative method of printing music of 
very high quality.  See Export/Import: <file://:Export/Import##3662>
¥   Fixed a bug which caused an open rectangle to appear in some printed tunes. 
¥   Guitar chords within a first/second repeat no longer collide with the bar which marks the repeat. 
¥   Fixed a bug which could cause a crash when using the Apply button in Viewer Preferences.
¥   Fixed a bug which caused a crash when processing tunes with large numbers of spaces at the ends of lines.

Changes since version 1.40

¥   Fixed a bug which could cause part of the tune title to be invisible when printing at high magnification under OS X.
¥   Fixed a bug which caused the program to hang in a loop, repeatedly displaying an "Unknown System Error" 
message when trying to display music from abc which contains a %%Bfly line written on another machine. (This 
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could also be caused by a corrupted preferences file.)

Changes since version 1.3b6

¥   There's a new sub-menu at the bottom of Utility which lets you choose between different ways of interpreting line 
ends in the text.  The new option here is "Staff break only on !".  This causes the program to act like the old 
ABC2WIN program when displaying music and when using some of the utility commands.  Line breaks in the text are 
ignored unless preceded by an exclamation mark, and you can also place exclamation marks in the middle of a line to 
force a staff break at that point.  This is useful when reading files generated by ABC2WIN, and may also be used to 
make the layout of the displayed music different from that of the abc text.
¥   The reverse apostrophe ` (is that what it's called?) can now be used in abc text as a low-visibility spacer if you need 
your text aligned in some special way.  It can be placed almost anywhere (except between a note and its length) and 
will not break beams or generate any errors.
¥   Aligned words (w:) can now use the barline "|" as a control symbol, meaning "wind on to the next bar", and can 
include hyphenated words if the hyphen is preceded by a backslash.
¥   Fixed a bug which caused the wrong window to close if you clicked on the close box of a back window under OS 
X.
¥   Fixed some minor problems when copying and pasting text into dialogs.
¥   The program now keeps the place when switching from split-screen to text mode, scrolling the current tune to the 
top of the window.
¥   The slur curvature control (in Viewer Preferences) now works properly.
¥        Whole-note (semibrieve) rests are now drawn in the correct vertical position (i.e. one line higher than 
previously).
¥   Fixed a bug which sometimes caused multivoice tunes containing chords to report spurious mismatched chord 
symbol errors.

Changes since version 1.3b5

¥   Fixed a bug which caused some memory corruption whenever you click on the index, leading to random crashes 
some time later.
¥   Fixed a problem with styled text when using files with PC style line ends.

Changes since version 1.3b4 

Printing is now available. Please read the Printing document:  <file://:Printing> 

The Beep sound has gone - it was only there for users who lacked a recent version of Quicktime, and since any 
machine that can run Carbon programs can also play Quicktime music it's no longer necessary.  The default instrument 
(which you cannot remove from the instrument menu) is now Piano.

Users who play through external midi can now specify in an abc tune what midi channel a single-voice abc plays 
through using:
 %%MIDI channel n 
where n is a number in the range 1 - 16.  In multivoice abc you can put channel directives in V: fields in the tune 
header (without the %%MIDI part) to specify the midi channel separately for each voice, and have each voice play on 
a separate synthesiser.

¥   Fixed a bug which caused a crash under OS X 10.1 and 10.1.5 when using antialiasing.
¥   Fixed a bug which caused a crash under OS X 10.1 the first time you add an instrument.
¥   Fixed a bug which could cause a crash when typing an accidental in aligned multivoice abc in split-screen mode.
¥   Fixed a bug which sometimes caused the scrollbar to become disabled after switching from split-screen to text 
mode.
¥   When live editing the end of a long tune, the staff display no longer scrolls back to the top, hiding the newly-added 
symbols.
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¥   Fixed a couple of minor bugs which could leave bits of misplaced selection colour lying around in the text and 
music panes.
¥   Fixed a bug which produced files with inconsistent line ends when PC line ends were selected.

Changes since version 1.3b3 

¥   Fixed a bug which caused the program to crash when opening files on some OS X versions. 
¥   Fixed a bug which caused mid-line metre or key changes where the field was written on a line to itself to cause 
notes to overflow onto the next line in the music display. 
¥   Fixed a bug in the macro expansion code which sometimes caused in-tune fields to become corrupted resulting in a 
spurious bad field message. 
¥   Fixed a bug which caused the preferences and registration dialogs to crash if there was no window behind them. 
¥   The Play Transposed menu command now works with multi-voice abcs.

Changes since version 1.3b2 

¥   Files containing styled text written by the Classic version are now translated on opening. 
¥   Fixed a bug which caused the program to sometimes select text beyond the end of the tune when playing. 
¥   A hang on tunes with alternate repeats written |  [1 (i.e. with spaces between the bar line and bracket ) is fixed. 
¥   Live editing of the text no longer suffers from flickering of the selection colour under Classic systems. 
¥   The option to use Ctrl and Option(alt) keys for octave shifts is working again. 
¥   The Revert to Saved command is working again. 
¥   Option-clicking in the front window's close box to close all windows works again. 
¥   Pasting a large block of text into the editor now properly recalibrates the scroll bar so you can scroll to the bottom 
of the window. 
(There may still be a problem or two with scroll bars;  if you find you can't scroll to the bottom of any pane, you can 
work around it by slightly re-sizing the window, which should recalibrate all the scroll bars.) 
¥   A bug which caused formatted text to get moved around after a file had been opened, edited and saved is fixed. 

Changes since version 1.3b1 

¥   When running under CarbonLib, all items in the Apple menu appeared twice.   Now fixed. 
¥   Graphic selection un-calibrated the music scroll bar, so you couldn't scroll to the bottom of the music.  Now fixed. 
¥   Program failed to set the default macro file properly on startup.  Now fixed. 
¥   Fermata lengthsÉ button in Player Preferences didn't work. Now fixed. 
¥   You can now dismiss the movable dialog boxes with the Return or Enter keys. 
¥   Fixed a bug which could cause a crash when opening files by command-clicking on a file reference. 
¥   Fixed a bug which could cause a crash when closing a window with no tunes in it. 

Changes from the Classic version 

¥   Offscreen drawing is now permanently on (it's an integral part of OS X). 
¥   TuneDaemon is gone (no longer required). 
¥   The editor has been completely re-written, and now uses Marco Piovanelli's WASTE engine.  
This has made possible some improvements to the interface, so you can now use Drag and Drop editing (it's an option 
in the General Preferences dialog).  Once a block of text is selected, you can drag it elsewhere within the same 
window, to another BarFly window, to a text window in another program, or out to the desktop to create a text 
clipping.  Likewise you can drag text into a BarFly window from another program, or even drag a whole text file from 
the Finder into a BarFly window to open the file.  Text which is dragged or copied to another program which supports 
styled text will appear with its styles and colours intact.  The format in which styled text is saved with files now 
conforms to the Mac standard, so that BarFly files can be opened and edited using TextEdit or SimpleText with the 
formatting intact. 
¥   All three scrollbars are now live, so dragging the scroll box causes the text, index or music to scroll synchronously. 
¥   You now have control over how line ends are marked in files.  General Preferences has new options to save new 
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files with Mac, Unix or PC line ends, and to preserve or replace the file ends when saving to existing files.  Note that 
the program uses Mac (CR) line ends internally, so this is the default setting (this format is quickest to save and open).  
Use Unix format if you want to use the Unix command-line tools on your files (vi, grep, abcm2ps etc), use PC format 
if you want to give files to a friend who uses a PC.  Otherwise it doesn't matter. 
¥   File opening dialogs will now see files with .abc or .txt extensions regardless of file signature. 
¥   When pasting text the program will normally insert styles and colours (if any), but you can force the program to 
paste plain text by holding down the option key before choosing Paste from the Edit menu. 

--------------------------------------------------------------------------------------------------------------------------------
---------------- 
Back to the table of contents: 

file://:Table of Contents 


	Local Disk
	file:///Applications/BarFlyCarbon1v74/Documentation/New%20in%20this%20Version


